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Abstract
These instructions give you guidelines for preparing papers for ICIUS 2022. Use this document as a template
if you are using Microsoft Word 2003 or later for Windows, or Word X or later for Mac OS X. Otherwise, use
this document as an instruction set. Underline the presenting/contact author. This first paragraph is formatted in
the abstract style. Abstracts are required only for regular, full-length papers. Be sure to define all symbols used
in the abstract, and do not cite references in this section. Article files should be provided in Microsoft Word
format and a PDF of the document. While you are welcome to submit a PDF of the document alongside the
Word file, PDFs alone are not acceptable. All submissions must include a structured abstract, following the
format outlined below. These four sub-headings and their accompanying explanations must always be included:
Purpose, Design/methodology/approach, Findings, Originality. The following three sub-headings are
optional and can be included, if applicable: Research limitations/implications, Practical implications, Social
implications,
You can find some useful tips on how to writte an abstract in the website
https://www.emeraldgrouppublishing.com/how-to/authoring-editing-reviewing/write-article-abstract.
The
maximum length of your abstract should be 250 words in total, including keywords.
Keywords Autonomous navigation, Bayesian approach, Mobile robot mapping, Occupancy grid mapping,
Sensor fusion

Nomenclature
(Nomenclature entries should have the units identified. Follow SI system of units.)
A =
amplitude of oscillation
a =
cylinder diameter
pressure coefficient
Cp =
Cx =
force coefficient in the x direction
Cy =
force coefficient in the y direction
c =
chord
dt =
time step
Fx =
X component of the resultant pressure force acting on the vehicle
Fy =
Y component of the resultant pressure force acting on the vehicle
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Introduction

This document is a template for Microsoft Word 2003 or later. If you are reading a hard-copy or .pdf version of
this document, download the electronic file, paper_template.doc, from the ICIUS 2022 website and use it to
prepare your manuscript. Papers must be written in English and submitted through the ICIUS 2022 conference
submission website. For the purpose of review only, manuscripts may be up to 6 pages long. All accepted
papers would be further reviewed for post conference journal publications in International Journal of Intelligent
Unmanned Systems (IJIUS). Any contributed or invited paper can be nominated for the ICIUS 2022 Best
Conference Paper Award and the ICIUS 2022 Best Student Paper Award
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General Guidelines

The following section outlines general (non formatting) guidelines to follow. These guidelines are applicable
to all authors and include information on the policies and practices relevant to the publication of your
manuscript.

ICIUS-2022-xxx (replace xxx with appropriate number assigned to your abstract)
2.1 Publication by ICIUS 2022
A book of abstracts for all selected papers will be published. Further, all selected papers will be added in a
USB Drive. All accepted papers would be further reviewed for post conference journal publications
in International Journal of Intelligent Unmanned Systems (IJIUS).
2.2 Copyright
ICIUS 2022 will not be responsible for any copyright violation of the material submitted in abstract or paper
form by authors.
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Detailed Formatting Instructions

The styles and formats for the ICIUS 2022 Template have been incorporated into the structure of this
document. If you are using Microsoft Word, please use this template to prepare your manuscript. If you are
reading a hard-copy or .pdf version of this document, please download the electronic template file,
PAPER_template.dot, from the conference website.
3.1 Document Text
The default font for the ICIUS 2022 Template is Times New Roman, 10-point size. In the electronic
template, use the “Text” style from the pull-down menu to format all primary text for your manuscript. The first
line of every paragraph should be indented, and all lines should be 1.15-spaced. Default margins are 1 in. on all
sides. In the electronic version of this template, all margins and other formatting are preset. There should be no
additional (blank) lines between paragraphs.
NOTE: If you are using the electronic template to format your manuscript, the required spacing and
formatting will be applied automatically, simply by using the appropriate style designation from the pull-down
menu.
3.2 Headings
Format the title of your paper in bold, 12-point type, with capital and lower-case letters, and center it at the
top of the page. The names of the authors, business or academic affiliation, city, and state/province follow on
separate lines below the title. The names of authors with the same affiliation can be listed on the same line
above their collective affiliation information. Author names are centered, and affiliations are centered and in
italic type. The affiliation line for each author includes that author’s city, state, and pin code (or city, state and
pin code, as appropriate).
Major headings in the template (“Heading 1” in the template style list) are bold 11-point font and centered.
Subheadings (“Heading 2” in the template style list) are bold, flush left.
3.3 Abstract
An abstract appears at the beginning of Full-Length Papers. (Survey and Design Forum Papers, History of
Key Technologies Papers, invited lectures, and Technical/Engineering Notes do not include abstracts.) The
abstract is one paragraph (not an introduction) and complete in itself (no reference numbers). It should indicate
subjects dealt with in the paper and state the objectives of the investigation. Newly observed facts and
conclusions of the experiment or argument discussed in the paper must be stated in summary form; readers
should not have to read the paper to understand the abstract.
All submissions must include a structured abstract, following the format outlined below. These four subheadings
and
their
accompanying
explanations
must
always
be
included:
Purpose,
Design/methodology/approach, Findings, Originality. The following three sub-headings are optional and can
be included, if applicable: Research limitations/implications, Practical implications, Social implications,
You can find some useful tips on how to writte an abstract in the website
https://www.emeraldgrouppublishing.com/how-to/authoring-editing-reviewing/write-article-abstract.
The
maximum length of your abstract should be 250 words in total, including keywords.

3.4 Nomenclature
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Papers with many symbols should have a nomenclature that defines all symbols with units, inserted between
the abstract and the introduction. If one is used, it must contain all the symbology used in the manuscript, and
the definitions should not be repeated in the text. In all cases, identify the symbols used if they are not widely
recognized in the profession. Define acronyms in the text, not in the nomenclature.
3.5 Biographies
Survey Papers and some Full-Length Papers include author biographies. These biographies are one
paragraph each and should use the abstract formatting style.
3.6 Footnotes and References
Footnotes, where they appear, are placed above the 1-in. margin at the bottom of the page. To insert
footnotes into the template, use the Insert>Footnote feature from the main menu as necessary. Footnotes are
formatted automatically in the template, but, if another medium is used, they should appear as superscript
symbols in the following sequence: *, †, ‡, §, ¶, **, ††, ‡‡, §§, etc.
List and number all references at the end of the paper. Corresponding bracketed numbers are used to cite
references in the text [1], including citations that are an integral part of the sentence (e.g., “It is shown in [2]
that…”) or follow a mathematical expression: “A2 + B = C (Ref. [3]).” For multiple citations, separate reference
numbers with commas [4, 5], or use a dash to show a range [6–8]. Reference citations in the text should be in
numerical order.
In the reference list, use first authors name followed by “et al.” instead of giving all authors name. Papers
that have not been published should be cited as “unpublished”; papers that have been submitted or accepted for
publication should be cited as “submitted for publication.” Private communications and personal Web sites
should appear as footnotes rather than in the reference list.
References should be cited according to the standard publication reference style. (For examples, see the
“References” section of this template.) Names and locations of publishers should be listed; month and year
should be included for reports and papers. For papers published in translation journals, please give the English
citation first, followed by the original foreign language citation.
3.7 Figures and Tables
Insert tables and figures within your document; they may be either scattered throughout the text or grouped
all together at the end of the file. Use the Table drop-down menu to create your tables; do not insert your figures
in text boxes. Figures should have no background, borders, or outlines. In the electronic template, use the
“Figure” style from the pull-down formatting menu to type caption text. You may also insert the caption by
going to the Insert menu and choosing Caption. Make sure the label is “Figure,” and type your caption text in
the box provided. Captions are bold with a single tab (no hyphen or other character) between the figure number
and figure description. See the Table 1 example for table style and column alignment. If you wish to center
tables that do not fill the width of the page, simply highlight and “grab” the entire table to move it into proper
position.
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Figure 1. Magnetization as a function of applied fields.
All figures should be supplied at the highest resolution/quality possible with numbers and text clearly legible.
Acceptable formats are .ai, .eps, .jpeg, .bmp, and .tif. Electronic figures created in other applications should be
supplied in their original formats and should also be either copied and pasted into a blank MS Word document,
or submitted as a PDF file. All figures should be numbered consecutively with Arabic numerals and have clear
captions.
Place figure captions below all figures. If your figure has multiple parts, include the labels “a),” “b),” etc.,
below and to the left of each part, above the figure caption. Please verify that the figures and tables you mention
in the text actually exist. When citing a figure in the text, use the abbreviation “Figure” except at the beginning
of a sentence.
3.8 Tables
Table I. Transitions selected for thermometry
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Do not abbreviate “Table.” Number each different type of illustration (i.e., figures and tables) sequentially
with relation to other illustrations of the same type. The position of each table should be clearly labelled in the
main body of the article with corresponding labels clearly shown in the table file. Tables should be numbered
consecutively
in
Roman
numerals
(e.g.
I,
II,
etc.).
Give each table a brief title. Ensure that any superscripts or asterisks are shown next to the relevant items and
have explanations displayed as footnotes to the table, figure or plate.
3.9 Equations
Equations are numbered consecutively, with equation numbers in parentheses flush right, as in Eq. (1). Insert
a blank line both above and below the equation. First use the equation editor to create the equation. If you are
using Microsoft Word, use either the Microsoft Equation Editor or the MathType add-on
(http://www.mathtype.com) for equations in your paper, use the function (Insert>Object>Create New>Microsoft
Equation or MathType Equation) to insert it into the document. Please note that “Float over text” should not be
selected. To insert the equation into the document, do the following:
1.1.1.1.1.1
Select the “Equation” style from the pull-down formatting menu, and hit “tab” once.
1.1.1.1.1.2
Insert the equation, and hit “tab” again.
1.1.1.1.1.3
Enter the equation number in parentheses.
A sample equation is included here, formatted using the preceding instructions:



r2
0

F (r, ) dr d  [r2 /(2o )] 


0

exp(-  | z j  z i |) 1J1 ( r2 )J 0 ( ri d )

Be sure that symbols in your equation are defined in the Nomenclature or immediately following the
equation. Also define abbreviations and acronyms the first time they are used in the main text.

(1)
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3.10 General Grammar and Preferred Usage
Use only one space after periods or colons. Hyphenate complex modifiers: “zero-field-cooled magnetization.”
Insert a zero before decimal points: “0.25,” not “.25.” Use “cm2,” not “cc.”
A parenthetical statement at the end of a sentence is punctuated outside of the closing parenthesis (like this).
(A parenthetical sentence is punctuated within parenthesis.) Use of American as well as English spellings (e.g.,
“color,” and “colour”) is allowed.
3.11

Paper Length

For the purpose of review only, manuscripts may be up to 6 pages long. All accepted papers would be
further reviewed for post conference journal publications in International Journal of Intelligent Unmanned
Systems (IJIUS).
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Conclusion

Although a conclusion may review the main points of the paper, it must not replicate the abstract. A
conclusion might elaborate on the importance of the work or suggest applications and extensions. Do not cite
references in the conclusion. Note that the conclusion section is the last section of the paper to be numbered.
The appendix (if present), acknowledgment, and references are listed without numbers.

Appendix
An Appendix, if needed, appears before the acknowledgments.

Acknowledgments
An Acknowledgments section, if used, immediately precedes the References. Sponsorship and financial
support acknowledgments should be included here.

References
All references in your manuscript must be formatted using one of the recognised Harvard styles. You are
welcome to use the Harvard style Emerald has adopted – we’ve provided a detailed guide below.
References to other publications in your text should be written as follows:


Single author: (Adams, 2006)



Two authors: (Adams and Brown, 2006)



Three or more authors: (Adams et al., 2006) Please note, ‘et al' should always be written in italics.
A few other style points. These apply to both the main body of text and your final list of references.



When referring to pages in a publication, use ‘p.(page number)’ for a single page or ‘pp.(page numbers)’ to
indicate a page range.



Page numbers should always be written out in full, e.g. 175-179, not 175-9.



Where a colon or dash appears in the title of an article or book chapter, the letter that follows that colon or
dash should always be lower case.



When citing a work with multiple editors, use the abbreviation ‘Ed.s’.
At the end of your paper, please supply a reference list in alphabetical order using the style guidelines below.
Where a DOI is available, this should be included at the end of the reference.
For books
Surname, initials (year), title of book, publisher, place of publication.
e.g. Harrow, R. (2005), No Place to Hide, Simon & Schuster, New York, NY.
For book chapters
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Surname, initials (year), "chapter title", editor's surname, initials (Ed.), title of book, publisher, place of
publication, page numbers.
e.g. Calabrese, F.A. (2005), "The early pathways: theory to practice – a continuum", Stankosky, M.
(Ed.), Creating the Discipline of Knowledge Management, Elsevier, New York, NY, pp.15-20.
For journals
Surname, initials (year), "title of article", journal name, volume issue, page numbers.
e.g. Capizzi, M.T. and Ferguson, R. (2005), "Loyalty trends for the twenty-first century", Journal of
Consumer Marketing, Vol. 22 No. 2, pp.72-80.
For published conference proceedings
Surname, initials (year of publication), "title of paper", in editor’s surname, initials (Ed.), title of published
proceeding which may include place and date(s) held, publisher, place of publication, page numbers.
e.g. Wilde, S. and Cox, C. (2008), “Principal factors contributing to the competitiveness of tourism
destinations at varying stages of development”, in Richardson, S., Fredline, L., Patiar A., & Ternel, M.
(Ed.s), CAUTHE 2008: Where the 'bloody hell' are we?, Griffith University, Gold Coast, Qld, pp.115-118.
For unpublished conference proceedings
Surname, initials (year), "title of paper", paper presented at [name of conference], [date of conference],
[place of conference], available at: URL if freely available on the internet (accessed date).
e.g. Aumueller, D. (2005), "Semantic authoring and retrieval within a wiki", paper presented at the European
Semantic Web Conference (ESWC), 29 May-1 June, Heraklion, Crete, available at: http://dbs.unileipzig.de/file/aumueller05wiksar.pdf (accessed 20 February 2007).
For working papers
Surname, initials (year), "title of article", working paper [number if available], institution or organization,
place of organization, date.
e.g. Moizer, P. (2003), "How published academic research can inform policy decisions: the case of
mandatory rotation of audit appointments", working paper, Leeds University Business School, University of
Leeds, Leeds, 28 March.
For encyclopaedia entries (with no author or editor)
Title of encyclopaedia (year), "title of entry", volume, edition, title of encyclopaedia, publisher, place of
publication, page numbers.
e.g. Encyclopaedia Britannica (1926), "Psychology of culture contact", Vol. 1, 13th ed., Encyclopaedia
Britannica, London and New York, NY, pp.765-771.
(for authored entries, please refer to book chapter guidelines above)
For newspaper articles (authored)
Surname, initials (year), "article title", newspaper, date, page numbers.
e.g. Smith, A. (2008), "Money for old rope", Daily News, 21 January, pp.1, 3-4.
For newspaper articles (non-authored)
Newspaper (year), "article title", date, page numbers.
e.g. Daily News (2008), "Small change", 2 February, p.7.
For archival or other unpublished sources
Surname, initials (year), "title of document", unpublished manuscript, collection name, inventory record,
name of archive, location of archive.
e.g. Litman, S. (1902), "Mechanism & Technique of Commerce", unpublished manuscript, Simon Litman
Papers, Record series 9/5/29 Box 3, University of Illinois Archives, Urbana-Champaign, IL.
For electronic sources
If available online, the full URL should be supplied at the end of the reference, as well as the date that the
resource was accessed.
Surname, initials (year), “title of electronic source”, available at: persistent URL (accessed date month year).
e.g. Weida, S. and Stolley, K. (2013), “Developing strong thesis statements”, available at:
https://owl.english.purdue.edu/owl/resource/588/1/ (accessed 20 June 2018)
Standalone URLs, i.e. those without an author or date, should be included either inside parentheses within
the main text, or preferably set as a note (Roman numeral within square brackets within text followed by the full
URL address at the end of the paper).
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For data
Surname, initials (year), title of dataset, name of data repository, available at: persistent URL, (accessed date
month year).
e.g. Campbell, A. and Kahn, R.L. (2015), American National Election Study, 1948, ICPSR07218-v4, Interuniversity Consortium for Political and Social Research (distributor), Ann Arbor, MI, available
at: https://doi.org/10.3886/ICPSR07218.v4 (accessed 20 June 2018)

